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Appendix 2 

Optimum Shelter Belts 

How to Guide 

Monitoring the characteristics of your Optimum Shelter Belt 

Christian Gossel, Farm Sustainability Researcher  

Introduction 

The role of porosity in shelterbelts/windbreaks (hereafter referred to as shelterbelts) is well 
recognised with numerous studies exploring how a change in porosity affects the qualities of the 
associated shelterbelt1,2. Many projects, such as Nelmes3, attempt to explore this relationship 
through models in wind tunnels, subsequently extrapolating their calculations to be applicable to in-
field scenarios. Utilising wind tunnel models allows for greater flexibility in exploring characteristics 
that can summarise shelterbelt qualities, thus reducing workloads when taking in-field assessments. 
Nelmes identified a single value, S, which requires only a handful of measurement to provide a 
general view of the aerodynamic impact of any shelterbelt. Specifically, S expresses the relationship 
between upstream velocity and downstream velocity through the equation: 

 

During this work she found that S has no relationship with porosity, suggesting that the ratio of 
upstream and downstream wind velocity in unaffected by the amount of air that can flow through 
the shelterbelt. In addition Nelmes suggests that porosity has little effect on the distance over which 
a change in velocity is felt. 

These results are in stark contrast to other studies which show that at low levels of porosity there is 
a large drop in velocity, but this effect is only felt over a small distance4. Likewise, at high porosity 
there is a smaller drop in velocity but over a larger area. This relationship, however, only holds for 
narrow shelterbelts and weakens as the shelterbelt width expands. Further work is needed to 
explore these differences by collecting data from in-field scenarios, testing S and its relationship to 
porosity, and confirming the association with porosity, velocity reduction, and area impacted. This 
will also help identify an optimal porosity to maximise protection effects, although this may vary 
between seasons. 

 
1 Cleugh, H. 1998. Effects of windbreaks on airflow, microclimates and crop yields. Agroforestry Systems. 41. 
p55-84. 
2 Mahgoub, AO & Ghani, S. 2021. Numerical and experimental invesƟgaƟon of uƟlizing the porous media 
model for windbreaks CFD simulaƟon. Sustainable CiƟes and Society. 65. 102648. 
3 Nelmes, S. 1999. The aerodynamic characterisaƟon of shelterbelts. PhD Thesis. University of Oxford.  
4 Ma, R et al. 2020. A wind tunnel study of the seasonal shelter efficiency of deciduous windbreaks. American 
Society of Agricultural and Biological Engineers. 63(4). p913-922. 
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Previous work has explored the topic on seasonal variations in shelterbelt quality, however the work 
utilising in-field experiments and measuring porosity variation over the seasons is limited4,5,6. The 
utilisation of a mix of deciduous and evergreen species if often recommended in shelterbelt planting. 
This mitigates some of the seasonal porosity changes but how the ratio of species can be optimised 
to offer the appropriate levels of protection at different times of the year is still unclear. Similarly, 
pruning, thinning, and other management activities are commonly only recommended when the 
shelterbelt becomes too dense or for tree health issues. Knowledge and data around how different 
approaches to tree management in shelterbelts relate to porosity is another area that needs further 
research. 

An additional aspect related to tree management which has yet to be explored through on-field 
experiments is the angle of tapering from lower to upper edges of the shelterbelt. Previous 
modelling experiments suggest that the shape (i.e. triangle or square face) doesn’t affect the 
sheltering qualities of the barrier7, however, an edging technique is common practice in commercial 
forestry to reduce the chance of windthrow8, particularly at the edges of the plantations. Having a 
tapered edge may therefore reduce damage to the shelterbelt from strong winds, however, how to 
optimise this effect in shelterbelts is unknown. By measuring the angle of taper, this methodology 
will be able to explore if the angle of taper has an impact upon shelter quality. Similarly over longer 
periods when storm may occur, noting the damage caused to the shelterbelt could be related to the 
angle. 

Finally, these protocols are developed to be used, in part, by farmers and landowners themselves. To 
this end, where possible they have been designed to be simple in approach and using basic 
equipment. Simple measurements such as tree height, however, can be done using an assortment of 
different methods, some of which may be more accurate than others. Previous work has compared 
technical methods of measuring tree height i.e. LiDAR against Clinometers9, however there is little 
research into comparisons of non-technical methods. Using a Clinometer is considered a standard 
method of measuring tree height and will be used as a reference value. Additional methods will also 
be used to measure tree height for comparison, the first using a spirit level mobile app as a proxy for 
measuring the viewing angle, much as a dedicated clinometer would. The second approach uses a 
piece of A4 paper folded to create a 45 degree angle from which the height can be deduced. Details 
of the methods used are detailed in the protocols below. 

General Approach 

This methodology aims to explore these areas by: 

1. TesƟng the relaƟonship between porosity and S on in-field examples. 
2. Capturing the link between porosity, windspeed reducƟon, and impacted area. 
3. IdenƟfying the temporal variaƟon in shelterbelt porosity. 

 
5 Koh, I. et al. 2014. Seasonal effecƟveness of a Korean tradiƟonal deciduous windbreak in reducing wind 
speed. Journal of Ecology and Environment. 37(2). p91-97. hƩp://dx.doi.org/10.5141/ecoenv.2014.011  
6 Baker, T. P. et al. 2021. Temporal, environmental, and spaƟal changes in the effect of windbreaks on pasture 
microclimate. 297. 108265. hƩps://doi.org/10.1016/j.agrformet.2020.108265  
7 Wang, Hao, and E. S. Takle. 1997. Model-simulated influences of shelterbelt shape on wind-sheltering 
efficiency. Journal of Applied Meteorology. 36 (6). pp695-704. DOI:10.1175/1520-0450-36.6.695.  
8 Gardiner, B., Stacey, G. 1996. Designing Forest Edges to Improve Wind Stability. Forestry Commission. 
Technical Paper 16. 
9 Ganz, S., Käber, Y., Adler, P. 2019. Measuring Tree Height with Remote Sensing—A Comparison of 
Photogrammetric and LiDAR Data with Different Field Measurements. Forests. 10 (8). pp694. DOI: 
10.3390/f10080694. 
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4. Exploring the impacts of different tree management strategies and tree types on seasonal 
porosity and other longer-term qualiƟes. 

The output of this work will allow offer greater clarity of the desired porosity for protection, which 
times of year this protection is at its maximum/minimum, and how management types and species 
selection can support this maximum/minimum protection. This can then be related to specific 
location climate and agricultural qualities i.e. crop disease vulnerability, livestock birthing, etc. 

Protocols 

Measuring optical porosity with a camera 

Rationale 

Optical porosity is a frequently used, low cost method of analysing the density of shelterbelts10. 
There are more detailed and vigorous approaches, such as LiDAR, are possible however the 
equipment is expensive and requires extensive training to use11. The below method describes a way 
of calculating the porosity without complex machinery, simply using a phone and online software. 
The software used has been used in other studies for this purpose and is free to access online12. 

Repeating the process across the seasons creates an understanding of how porosity and thus shelter 
effects change over the year, feeding into future recommendations around optimal design for 
maximising shelter effect at certain times of year. 

Method 

Take 3 identical sets of photos which capture the full height of the shelterbelt without any 
obstructions. Where possible try to take the photo positioned perpendicular to the shelterbelt. The 
photo should not be angled up or down, being perpendicular to the ground. In addition try to 
minimize the level of blurring or other artefacts in the photo and capture the highest resolution 
possible. 3 photos are required to account for any changes in opacity due to leaves moving in the 
wind and to provide a more accurate final value. Ensure the sky is visible through the trees and no 
buildings are situated directly behind the shelterbelt in the photos.  

Transfer the photos to a computer and open Fiji/imageJ or visit https://ij.imjoy.io/ - will take a few 
minutes to load. 

File > open… > select local file, then browse to where you have the photos saved and open one. 

Once the photo has loaded select the rectangle on the menu and then draw the rectangle over the 
trees so that the top of the trees is at the top of the rectangle, and the bottom of the trees is at the 
bottom of the rectangle. This is to remove any excess sky or crops/pasture that would lead to an 
incorrect analysis. 

 
10 Wu, Tonggui., Zhang, Peng., Zhang, Lei., Wang, Jingyuan., Yu, Mukui., Zhou, Xinhua., Wang, Geoff. 
RelaƟonships between shelter effects and opƟcal porosity: A meta-analysis for tree windbreaks. 2018. 
Agricultural and Forest Meteorology. 259. pp 75-81. hƩps://doi.org/10.1016/j.agrformet.2018.04.013.  
11 Nowak, Maciej M., Pędziwiatr, Katarzyna., Bogawski, Paweł. Hidden gaps under the canopy: LiDAR-based 
detecƟon and quanƟficaƟon of porosity in tree belts. 2022. Ecological Indicators. 142. 109243. 
hƩps://doi.org/10.1016/j.ecolind.2022.109243. 
12 Marais, Zara E., Baker, Thomas P., A. Hunt, Mark., Mendham, Daniel. Shelterbelt species composiƟon and age 
determine structure: Consequences for ecosystem services. 2022. Agriculture, Ecosystems & Environment. 329. 
107884. hƩps://doi.org/10.1016/j.agee.2022.107884.  
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Image > Type > 8-bit 

This will convert it to a black and white-style image. 

Process > binary > make binary 

This will convert it to a full binary (black and white pixels only) image. 

Analyze > Histogram 

If a box pops up then just press continue/OK until you get to a graph. The graph will appear blank 
but this is just because there are only two values on the spectrum, pure black and pure white. 

Click “List” on the lower left of the graph. This will provide a list of the number of pixels at each 
colour. 0 is the number of black pixels and 255 is the number of white pixels. 

To work out the porosity: 

 

This gives a value for porosity between 0 (no porosity) and 1 (full porosity). To convert it to a 
percentage, times by 100. 

Repeat for the other two photos. Once you have the 3 porosity values, add them together and divide 
by 3 to get an average porosity. 

Repeat this methodology for a few different days in the week, aiming to capture photos in a range of 
light levels with cloudy and sunny backdrops. This will help remove error when calculating the 
number of object vs background pixels. The values of porosity under these different conditions can 
then be averaged. 

Repeat this process for each of the 4 seasons to get an understanding of how porosity varies across 
the year. 

Equipment 

Camera (can be phone or dedicated camera) 

Computer with access to internet 

Additional Comments 

Timings are non-critical – as long as most farms capture the seasons within a few weeks of each 
other. 

Could be done my farmers (particularly the photo taking). They could then just email images over 
with dates for researcher analysis. 

 

Measuring optical porosity with a drone 

Rationale 
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Drones are becoming increasingly affordable and user friendly, providing another tool that can 
capture suitable imagery13. The ease with which drones allow for photo or video capture in a 3D 
space offers the opportunity to take picture at 90 degrees to the shelterbelt, increasing the accuracy 
of porosity calculations as well as allowing for images to be taken in areas where ground conditions 
may make it difficult to take photographs on the ground. 

Method 

Hover the drone at half the height of the trees (see measuring tree height for identifying this value). 
Position the drone so it is perpendicular to the shelterbelt and images are taken flat on (i.e. not 
aimed towards the sky/ground). Take a 3 second video or 3 still images. 

Transfer the video/images to PC. If using video isolate 3 frames, 1 for each second, resulting in 3 still 
images. 

Open Fiji/imageJ or visit https://ij.imjoy.io/ - will take a few minutes to load. 

File > open… > select local file, then browse to where you have the photos saved and open one. 

Once the photo has loaded select the rectangle on the menu and then draw the rectangle over the 
trees so that the top of the trees is at the top of the rectangle, and the bottom of the trees is at the 
bottom of the rectangle. This is to remove any excess sky or crops/pasture that would lead to an 
incorrect analysis. 

Image > Type > 8-bit 

This will convert it to a black and white-style image. 

Process > binary > make binary 

This will convert it to a full binary (black and white pixels only) image. 

Analyze > Histogram 

If a box pops up then just press continue/OK until you get to a graph. The graph will appear blank 
but this is just because there are only two values on the spectrum, pure black and pure white. 

Click “List” on the lower left of the graph. This will provide a list of the number of pixels at each 
colour. 0 is the number of black pixels and 255 is the number of white pixels. 

To work out the porosity: 

 

This gives a value for porosity between 0 (no porosity) and 1 (full porosity). To convert it to a 
percentage, times by 100. 

Repeat for the other two photos. Once you have the 3 porosity values, add them together and divide 
by 3 to get an average porosity. 

 
13 Torresan, Chiara., Berton, Andrea., Carotenuto, Federico., Filippo Di Gennaro, Salvatore., Gioli, Beniamino., 
Matese, Alessandro., MiglieƩa, Franco., Vagnoli, Carolina., Zaldei, Alessandro., Wallace, Luke. 2017. Forestry 
applicaƟons of UAVs in Europe: a review. InternaƟonal Journal of Remote Sensing. 38 (8-10). pp 2427-2447. 
hƩps://doi.org/10.1080/01431161.2016.1252477  
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Repeat this methodology for a few different days in the week, aiming to capture photos in a range of 
light levels with cloudy and sunny backdrops. This will help remove error when calculating the 
number of object vs background pixels. The values of porosity under these different conditions can 
then be averaged. 

Repeat this process for each of the 4 seasons to get an understanding of how porosity varies across 
the year. 

Equipment 

Drone with camera 

Computer with internet access 

Additional comments 

Timings are non-critical – as long as most farms capture the seasons within a few weeks of each 
other. 

Drones would need to be flown by trained individuals, however the image analysis steps could be 
done by anyone. 

 

Measuring windspeed values using anemometers 

Rationale 

Windspeed is the primary indicator for shelter effect of shelterbelts. Methods to measure 
windspeed in field vary, however, Nelmes (1999) identified a simplified measurement model for 
windspeed which requires fewer readings. This methodological approach will allow for testing of the 
model’s performance in field settings, while also collecting the necessary data to associate 
windspeed with optical porosity. 

Additional readings to those required for S will also need to be taken to validate S and provide a 
greater understanding of the size of shelter effect across the field.  

Method 

As per Nemes 1999: 
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In addition readings should be taken at 5, 10, 15, and 20H distance however these don’t have to be 
simultaneous if the number of anemometers is limited. The same methodology for the S readings 
should be used to take these readings i.e. 0.4h height for 10 minutes. 

Ideally these will be repeated near the middle of every season, resulting in 4 sets of readings per 
year. 

Equipment Required 

Anemometers (minimum of 2) 

Additional Comments 

Wind measurements should be taken on days that are not extremely windy, but also not extremely 
still. 

Anyone could carry out these measurements, but given the time and equipment required a 
researcher may be best suited. 

As access is only guaranteed on both sides of the shelterbelt for 15 sites. Of those 15 only 10 are 
angled roughly perpendicular to the prevailing wind, potentially limiting the number of samples that 
can be taken. 

 

Measuring windspeed values using a drone 

Rationale 
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While relatively novel, the notion of measuring windspeed via drone has been trialled in multiple 
scenarios14,15,16. This approach offers the ability to access windspeed at any 3D point in space across 
the shelterbelt. Current drone capabilities limit recordings to under 10 minutes and recording cannot 
be taken simultaneously unless multiple drones are used. Despite these limitations the potential of 
this method should be explored 

Method 

Numerous approaches could be taken to calculate the windspeed from drones13,14,15. 

The positioning of the drone to collect data should be independent of the method used to extract 
windspeed, however the time required at each location and the number of locations may be limited 
by battery availability. 

Taking readings for 0.4H in height should be done at 1, 5, 10, 15, 20H distance from the shelterbelt 
on the leeward side. 

Equipment Required 

Drone 

Additional Comments 

Timings are non-critical, Wind measurements should be taken on days that are not extremely windy, 
but also not extremely still. However, since these data are of importance to other measures included 
in the research, they will be aligned with relevant times of day/year for key moments in these 
protocols such as seed germination or animal shade/shelter. 

Drones would need to be flown by trained individuals. 

 

Measuring tree height with a clinometer 

Rationale 

A near universal standard for measuring trees is to use a clinometer. Other options are available 
such as laser-based height measurers, however these are more expensive and pose additional risks 
for the user. Tree height is required to calculate various other values, such as the positioning of 
anemometers/drones. The height also plays and important role in determining the sheltering 
effect17. 

Method 

 
14 Simma, M., Mjøen, H., Boström, T. 2020. Measuring Wind Speed Using the Internal StabilizaƟon System of a 
Quadrotor Drone. Drones. 4 (2). hƩps://doi.org/10.3390/drones4020023. 
15 Thielicke, W., Hübert, W., Müller, U., Eggert, M., and Wilhelm, P. 2021. Towards accurate and pracƟcal drone-
based wind measurements with an ultrasonic anemometer. Atmospheric Measurement Techniques. 14 (2). pp 
1303-1318. hƩps://doi.org/10.5194/amt-14-1303-2021.  
16 Crowe, D.; Pamula, R.; Cheung, H.Y.; De Wekker, S.F.J. 2020. Two Supervised Machine Learning Approaches 
for Wind Velocity EsƟmaƟon Using MulƟ-Rotor Copter Aƫtude Measurements. Sensors. 20 (19). 5638. 
hƩps://doi.org/10.3390/s20195638.  
17 Zhou, X.H., Brandle, J.R., Mize, C.W, Tackle, E.S. 2005. Three-dimensional aerodynamic structure of a tree 
shelterbelt: DefiniƟon, characterizaƟon and working models. Agroforestry Systems. 63. pp133-147. 
hƩps://doi.org/10.1007/s10457-004-3147-5.  
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Place a tape measure in the middle of the windbreak (i.e. if 5m deep then place at 2.5m). with the 
tape measure, walk in a perpendicular line out into the field until you can comfortably look up and 
see the top of the tree line. Raise the clinometer to your eye and match the line/site with the top of 
the treeline (use an average of the treeline, not an individual tree). Note the percentage 
measurement on the clinometer and the distance on the tape measure. 

The height of the treeline can be calculated via 

 

Repeat for 5 sections along the shelterbelt to get an average height. 

A single reading should suffice for each year. 

Required Equipment 

Tape measure (10m+) 

Clinometer 

Additional Comments 

This is not time critical and can be done at any time of year. 

Anyone can complete this work. 

 

Measuring tree height with a spirit level mobile app 

Rationale 

Similar in method to the Clinometer, a sprit level mobile app aims to measure the angle of viewing. 
This approach is of interest as mobile phones are a common item that could replace the role of a 
dedicated tool (clinometer), reducing cost and equipment for surveyors. 

Method 

Following the protocol described by Gabriel Henry18. Download a spirit level app to the smartphone. 
Place a tape measure in the middle of the windbreak (i.e. if 5m deep then place at 2.5m). with the 
tape measure, walk in a perpendicular line out into the field until you can comfortably look up and 
see the top of the tree line. Hold the phone up to one eye so that you are looking along the phone to 
the top of the tree line (use an average of the treeline, not an individual tree) and take a note of the 
angle shown on the spirit level. It may be preferable to get an app which allows you to “pause” the 
measurement to make reading easier.  

The height of the treeline can be calculated via 

 

Repeat for 5 sections along the shelterbelt to get an average height. 

A single reading should suffice for each year. 

 
18 hƩps://gabrielhemery.com/how-to-calculate-tree-height-using-a-smartphone/  
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Required Equipment 

Tape measure (10m+) 

Smartphone with spirit level app 

Additional Comments 

This is not time critical and can be done at any time of year. 

Anyone can complete this work. 

 

Measuring tree height with a piece of paper 

Rationale 

Another simple method of measuring tree height is using a paper folded to make a right angle. This 
eliminated the requirement for a mobile phone or dedicated device i.e. clinometer, however, also 
requires a clear space around the tree in order to stand at the correct distance. As such this 
approach wouldn’t be effective in a woodland setting, however for this scenario with fields 
surrounding the shelterbelt there should be little to no obstructions allowing the required distance 
to be measured easily. 

Method 

Based on the protocol described on WikiHow19. Fold a piece of A4 paper to create a right angle 
where you can look along the hypotenuse. Place a tape measure in the middle of the windbreak (i.e. 
if 5m deep then place at 2.5m). With the tape measure, walk in a perpendicular line out into the 
field until you can look along the hypotenuse, with the bottom of the triangle parallel to the ground, 
and see the top of the tree line (use an average of the treeline, not an individual tree). 

The height of the treeline can be calculated via 

 

Repeat for 5 sections along the shelterbelt to get an average height. 

A single reading should suffice for each year. 

Required Equipment 

Tape measure (10m+) 

Piece of A4 paper 

Additional Comments 

This is not time critical and can be done at any time of year. 

Anyone can complete this work. 

 

 
19 hƩps://www.wikihow.com/Measure-the-Height-of-a-Tree#Using-a-Piece-of-Paper  
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Measuring shelterbelt profile 

Rational 

Shelterbelt profile is unlikely to impact the sheltering effect itself, however a gently sloping profile is 
frequently recommended in traditional forestry to reduce windthrow. By measuring the slope profile 
the aim is to identify any correlation between windfall/damage and slope profile. This will require 
longer-term monitoring of the shelterbelt with particular focus at times of extreme wind. 

Method 

There are two possible angles to measure depending on the shelterbelt design. The first assumes 
that a single tree defined the edge of the shelterbelt. In this case, using a clinometer stand at the 
base of the furthest outreach of the canopy base and point the clinometer to the top of tree (orange 
line on Figure 1). If the top cannot be seen then estimate where the top of the tree would be. Repeat 
this at each point that a height reading is taken.  

The second design uses multiple rows of the trees at an increasing height until the top of the 
shelterbelt is reached. In this scenario, out from the smallest tree until you can look across the tree 
tops up to the highest point (orange line on Figure 2). Use the clinometer to measure this angle. 
Repeat this at each points that a height reading is taken. 

Equipment Required 

Clinometer 

Additional Comments 

This is not time critical and can be done at any time of year. 

Anyone can complete this work. 

 

Measuring shelterbelt depth 

Rational 

Shelterbelt depth is required to measure height and also adds to the visual understanding of 
shelterbelt characteristics that may impact the sheltering effect16. 

Method 

If access to both sides of the shelterbelt is possible with the ability to move through the 
undergrowth, then place one end of the tape measure on the leeward side at the point where the 

Figure 1. Diagram modified from Gardiner & Stacey, 1996. 

Figure 2. Diagram modified from Gardiner & Stacey, 1996. 
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canopy reaches out the furthest. Take the tape measure through the understory of the shelterbelt 
and place the end at the point where the canopy reaches out the furthest. Note the distance on the 
tape measure. Repeat this at least 3 more times along the shelterbelt to get an average width. 

Equipment 

Tape measure (10m+) 

Additional Comments 

This is not time critical and can be done at any time of year. 

Anyone can complete this work. 

 

Measuring species ratio 

Rational 

There is likely to be seasonal variation in porosity, however this will be impacted by the ratio of 
evergreen in the shelterbelt. By categorising the ratio of deciduous to evergreens, the species mix 
can be related to optical porosity and windspeed, feeding into the future recommendations for 
shelterbelt planting. 

Method 

If known from planting then: 

 

The greater the number is above one, the more deciduous species are present. The smaller the 
number is to zero, the greater the dominance of evergreens. 

If the species planted and ratio isn’t already known, then measurements will have to be taken. Walk 
along a 20m stretch of the leeward side of the shelterbelt and tally the number of deciduous and 
evergreen trees visible. Do the same for the windward side. If time allows then repeat these steps 
for 2 additional sections of the shelterbelt. The results can then be entered into the equation. 

Equipment Required 

Notebook, pen, calculator 

Additional Comments 

Timings are non-critical. 

Anyone can carry out these measurements. 

 

Data Analysis 

Variables 

For each shelterbelt: 
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 Windspeeds at: 
o Windward 

 1H distance, 0.4H height 
o Leeward 

 1H distance, 0.4H height 
 5H distance, 0.4H height 
 10H distance, 0.4H height 
 15H distance, 0.4H height 
 20H distance, 0.4H height 

 Porosity – 4 readings a year with dates, averaged from mulƟple repeats. 
 Tree height – 3 values per year (3 different methods) 
 Shelterbelt Profile – 1 value per year 
 Shelterbelt depth – 1 value per year 
 Species RaƟo – 1 value 

 

Calculated Variables 

D70 

Plotting the Windspeeds from 1H, 5H, 10H etc. up to 20H will provide a relationship between 
windspeed and distance for a specific porosity. An appropriate equation should be identified to 
describe this relationship. This equation can then be utilised to calculate 70% of the velocity 
measured at 1H on the windward side (or whichever value was taken as a representation of this). 

This can be repeated for each site allowing for D70 and velocity relationship equations to be 
calculated for different porosities. 

Relative windspeed reduction 

 

S 

 

 

Plots and analysis 

 Plot Porosity against D70 – calculate correlaƟon co-efficient 
 Plot Porosity against windspeed reducƟon – calculate correlaƟon co-efficient 
 Plot porosity against S – calculate correlaƟon co-efficient 
 Plot Porosity for each season – ANOVA with seasons as the group 
 Plot Porosity for each season with an addiƟonal grouping of species raƟo 

 

 


